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ABSTRACT 
 
 
 

 

The main objective of this Project is to Design and carry out the Analysis of a water jet 

propulsive patrolling vessel along the coast, in the rivers, in the lakes. Main aim is to define the 

project with improved propulsive efficiency by working on analysis of cavitation and flow analysis 

with model of 6 bladed propeller using CFX. This project illustrates the modelling and analysis of a 

water jet propeller installed in Patrolling vessel in order to achieve improved propulsive efficiency. 

 

             The modelling and analysis of water jet propulsion system was performed to provide detail 

understanding of complicated three-dimensional viscous flow phenomenon including interactions of 

intake duct, impeller, stator and contracted discharge nozzle. To handle interface boundary between 

stator and rotor, the complicated viscous flow feature of water jet flow such as the secondary flow 

inside the intake duct, the recovery of axial flow by the action of stator  and tip vortex etc., were 

well understood by the present simulation. The performance of thrust and torque is predicted.  

 
 
 

The hydrodynamic pressure changes, detailed flow analysis, velocity stream flow and 

cavitation analysis were done with a 6 bladed Impeller using CFX. This work helps in 

understanding the cavitation and flow with the respective blade and prospects with the change in 

number of blade can be reviewed. Improved propulsive efficiency with respect to change in blade 

rake angle can be achieved with this analysis. 
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CHAPTER 1 
 

INTRODUCTION 



 

1. INTRODUCTION 
 

1.1 INTRODUCTION OF HINDUSTAN SHIPYARD LIMITED: 
 

Hindustan Shipyard Limited (HSL) the pioneer ship building industry in India is 

the first ISO 9001-2000 certified shipyard of the nation and currently certified by ISO 

9001-2008 strategically located on the East Coast of India in Andhra Pradesh at 

Visakhapatnam at 83.17’E longitude and 73.41’N latitude. It is the part of the natural 

harbour of Visakhapatnam. 

 
 

The harbour provides a direct natural passage into the yard. It is located at a 

distance of 15 KM from the city at Scindia and is well connected from all the parts of 

the city. The yard is precisely and compactly laid out of 46.2 Hectors area of land. The 

organization has outstanding infrastructure, trained workforce, wealthy experience and 

proficiency in building and repairing ships of all types. By making audacious 

investments in encouragement talent and raise its technologies and services. HSL is 

making great strides towards becoming a leader in ship building and ship repairs. 

 
 

It has an tremendous track record of consistency and value of product. With its 

full-fledged facilities, the yard is specialized in submarine repairs. The shipyard had 

built 172 vessels and repaired nearly 1904 ships and can put forward the wide-ranging 

services beneath the crown in design, erection, renovation and repairs. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig1.1 LAYOUT OF HSL  
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The yard has three slipways, a covered building dock, a wet basin and a dry 

dock along with necessary facilities required for shipbuilding, ship repairs and 

submarine repairs. 
 

Over a period of time the yard has been able to emerge as a one of the major 

players in the Indian maritime sector. The factors that make HSL stand out are as 

under:- 
 

 Largest shipyard on the East coast of India.


 Well laid out facilities with steel throughput capacity of 20000 tons/ year.


 Only shipyard with submarine repair capability on the East coast.


 Large covered building dock for un-interrupted work round the year.


 Strategically located at harbour entrance (water depth of about 10 mt).


 Located close to major customers viz. ENC, DCI and VPT.


 Capable of building ships up to 80,000 DWT.


 Excellent Quality of work with low rejection rates.


 850 m of wharf age with adequate carnage.


 Large dry-dock & wet basin with exclusive workshops to facilitate ship repairs.


 Carnage to handle blocks / loads up to 300 tons.


 Three low bed transporters up to 200 tons capacity.


 ISO 9001 / 2008 certified yard


 Good quality assurance system & test facilities.
 

 

1.1.1 HISTORICAL BACKGROUND OF HSL: 
 

Scindia Steam Navigation Company (SSNC) was established at the present 

place of HSL in 1941. After building 8 ships, the SSNC was unable to finance the 

organizations, considering the national and strategic importance of the ship industry. 

The government of India acquired two third of the share in 1952 and the balance of one-

third was held by this Scindia Steam Navigation Company. Later in July 1961 the 

remaining share was also acquired by the government on India and has renamed it as 
 

‘HINDUSTAN SHIPYARD LIMITED’.  
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Fig1.2 LAYOUT OF SSNC 
 

VARIOUS DEPARTMENTS IN HSL: 
 

The departments in the shipyard are broadly classified into three categories: 
 

 Ship building department


 Ship repair department


 Submarine retrofit department
 

The departments/divisions in the HSL can broadly be classified into two categories, 

they are: 
 

I. Technical 
 

a. Production departments 
 

 Hull shop department


 Prefabrication department


 Erection department


 Loft department


 Shipwright department


 Hull testing department


 Welding department


 Black smith department


 Joiners and Carpentry department


 Sheet metal department


 Rigging department 
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 Painting department


 Electrical department


 Plumbing department


 Engineering department


 Galvanizing department 

b. Non – production departments


 Design office


 Quality assurance and quality check


 Purchase and material department




II. Non – technical 


 Personal and administration department


 Finance/accounts department


 Services
 

 

ACTIVITIES AT HSL: 
 

The main activities of the Hindustan Shipyard Limited are as follows: 
 

 Ship Building


 Ship repair


 Submarine Retrofit


 Construction and repair of onshore and offshore structures
 

 

1.1.2 SHIP BUILDING: 

 

The yard is outfitted with the plasma cutting machines, steel processing 

facilities, material handling and transportation equipment, cranes and sizes, logistic and 

storage conveniences, Quality Check division with testing and measuring services & 

welding machinery to ensure that the vessels are constructed as per the rules and of 

excellence standards. The shipyard has division and out-and-out infrastructure and 

amenities for ship building. 
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1.1.3 SHIP REPAIR: 
 

The yard has a full-fledged and independent ship repair department with a 

Graving dock, Wet basin, Outfit jetty and other facilities. Almost 1904 ships including 

cargos, bulk carriers, petrol vessels, and passenger ships were repaired at the yard till 

date. 

 
 

1.1.4 SUBMARINE RETROFITTING: 
 

HSL is specialized in submarine repairs. It has repaired various submarines like 

F-Class submarine and 877EKM submarine. It has all sort of infrastructure to carry out 

the submarine retrofitting process. 

 

 

1.1.5 CONSTRUCTION AND REPAIR OF ONSHORE AND 

OFFSHORE STRUCTURES: 

 

 

 

Type of Ships (Sector) No. of ships delivered by HSL 

  

Maritime sector 121 

  

Defence Sector 11 

  

Oil sector 22 

  

Total 154 

  

TABLE1: PROJECTS OF HSL  
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1.2 INTRODUCTION TO SHIPS: 
 

SHIP: 
 

A ship may be regarded as vessel of hollow structures made to float on water and 

capable of conveying goods from one place to another across the surface of water. 

 

Ship, vessels that is buoyant in the water and used to transport people or cargo from one 

place to another via rivers, lakes or oceans. Traditionally, ships were distinguished from 

boats by size any buoyant vessels small enough to fit on board a ship was considered a 

boat. Based on" Archimedes" principle ships will float. 

 
 

 

ARCHIMEDE 'S PRINCIPLE: 
 

 An object is subjected to an upward force when it is immersed in liquid. The 

force is equal to the weight of the liquid displaced.


 This principle also known as the law of hydrostatics, applies to both floating and 

submerged bodies to all fluids.
 
 
 

BUOYANCY: 
 

Buoyancy is an upward force exerted by a fluid that opposes the weight of an immersed 

object. In a column of fluid, pressure increases with depth as a result of the weight of 

the overlying fluid experiences greater pressure than at the top. This difference in 

pressure results in a net force that tends to accelerate an object upwards. The magnitude 

of that force is proportional to the difference in the pressure between the top and the 

bottom of the column and (as explained by Archimedes principle) is also equivalent to 

the weight of the fluid that would otherwise occupy the column that is the displaced 

fluid. 

 

Any object will either float or sink in water depending upon the density. If it is 

more dense than water it will usually sink. If it is less dense than water it will float. 
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Fig 1.3.1 PRINCIPLE OF BUOYANCY 
 
 

 
 
 
 

 
 
 
Fig 1.3.2PATROLLING VESSEL 
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1.3 TERMINOLOGY OF SHIPS: 
 

Aft/After: 
 

The direction towards the rear of the ship is called aft or after. 
 

Forward/Fore: 
 

The direction towards the front or bow of the ship is called forward –fore. 
 

Mid ship: 
 

The centre of the ship located at the midpoint between the fore and aft perpendicular is 

called the mid ship. 
 

Forward Body: 
 

The portion of the ship from mid ship to the front or bow of the ship is called forward 

body. 
 

Port: 
 

The left hand side of the ship, when looking from the fore is called port side. 
 

Fore and Aft: 
 

In the line with length of the ship is called fore and aft. 
 

Arch wart ship: 
 

The part across the ship at right angles to the fore and aft centre line of the ship is called 

arch wart ship. 
 

In-Board: 
 

The direction towards the centre line of the ship is called in-board. 
 

Out-Board: 
 

The direction away from the centre lone or towards the side of the ship is called out-

board. 
 

Stem: 
 

The bow of the ship, the part where the port and starboard meet extending from keel to 

forecastle deck is called stem of the ship. 
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Stern: 
 

The aft end of the ship is known as stern. 
 

Bow: 
 

Forward end of the ship is known as bow. 
 

Stern-Frame: 
 

Large casting or forging or built up frame attached to the aft end of the keel to from the 

ship’s structure is known as stern-frame. 
 

Rudder: 
 

A large heavy fitting hinged to stern frame which is used for steering of the ship is 

known as rudder. 
 

Keel: 
 

Keel is the back bone of the ship. It is the principal fore-aft member which runs along 

the bottom and connects the stem and the stern. 
 

Centre Girder: 
 

Centre girders are fore and aft vertical plates fitted at the centre line upon the keel and 

to which the half floor plates are connected by welding or by vertical angle bars. 

Sometimes they are also called the ‘vertical-keel’. 
 

Floor: 
 

A floor is a transverse vertical plate running across the bottom of the ship. 
 

Inter-Costal: 
 

An inter-costal plate is a vertical fore and aft plate fitted between the floors, also short 

length of the plate or bar between frames beams, etc. they are not continuous. 
 

Frames: 
 

One of the ribs forming the skeleton of the ship is known as a frame. They act as 

stiffeners holding the outside plating in shape and maintain the transverse form of the 

ship. 
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Frame-Line: 
 

The fixed position or point of the frame or the frame station fixed to the ship is known 

as frame-line. 
 

Frame Spacing: 
 

The fore and aft distance between the heels of the frame to heel of the transverse frame 

measured along the transverse line is called as frame spacing. 
 

Bulk Head: 
 

The vertical portion in ship which divides the interior of the ship into various 

components is known as bulk head. 
 

Aft-Peak: 
 

The water tight compartment aft of the cast watertight compartment is known as aft-

peak. 
 

Fore peak: 
 

A large compartment in the tank at the bow in the lower point of the ship is known as 

fore peak. 
 

Deck: 
 

Deck is the horizontal platform corresponding to the floor in the building. 
 

Beam: 
 

Beam is the transverse horizontal member supporting a deck o a flat extreme width of 

the deck. 
 

Deck Girder: 
 

A continuous member running in the fore and aft direction under the deck for the 

purpose of supporting the deck and beams is known as deck girder. 
 

Stiffener: 
 

A section fastened to the surface to strengthen it and make it rigid is called a stiffener.  
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Camber: 
 

A transverse curvature or crown given to the decks for the purpose of draining rain or 

sea water to the sides. 
 

Hatch: 
 

Opening the deck for passage of cargo into the hull is known as hatch. 
 

Coming: 
 

The vertical boundary of the hatch or skylight or for any other opening is known as 

coming. 
 

Bracket: 
 

A triangular piece of plate used to connect rigidly two or more parts that meet at some 

angle with ne and other. For example, a deck beam attached to the frame or frame to 

margin plate. 

 

Butt: 
 

The joint that is formed when two parts are placed edge to edge also end joint between 

two plates. 

 

Seam: 
 

The fore and aft joint or length wise side joint of the plates is known as steam. 

 

Lap: 
 

A joint in which one part of the plates overlaps the other thus obtaining the use of butt-

strap is known as lap joint. 
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Fig 1.4 BASIC TERMINOLOGY OF A SHIP 
 
 

 

1.4 BASIC DISCRIPTION OF SHIPS: 
 

The fore end of the ship is called bow and rear end is known as stern or aft .The left 

hand and right hand side of the ship when viewed from the stern are called port and star 

board. 

 

MAIN PARTS OF SHIPS: 
 

1. Smokestack or Funnel 

 

2. Stern 

 

3. Propeller or Rudder 

 

4. Portside 

 

5. Anchor 

 

6. Bulbous bow 

 

7. Bow 

 

8. Deck 

 

9. Superstructure 

 

                                Fig 1.5 PARTS OF THE SHIP  
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CHAPTER-2  

LITERATURE REVIEW 



 

2. LITERATURE REVIEW 
 

 

Automation was the rage of engineering world. The investigation on the existing 
 

Patrolling vessel reviews the following drawbacks such as high investment cost, high usage 
 

Of manpower for patrolling, by using these existing patrolling vessels we can travel up to 
 

Some extent but by using our innovative patrolling vessel we can travel is wherever the 
 

Solar power is available. 
 

This is one of the research projects of HINDUSTAN SHIPYARD LIMITED which 

is Undergoing to be done in the number name F47 & F48 and we have taken the concept of 

that research project and the design parameters are taken from the normal patrolling vessel. 

This is an innovative project where no ship was made by using both the concept of solar 

power and remote controller. 

 

 

Marine propellers, although submerged in water aft of the ship, form an integral part of a 

ship and play a vital role in ship propulsion. Much has been said and published on the 

development of the marine propeller from the time of antiquity to the present age, but there 

is more to be done. The movement of a ship through water is achieved by the power so 

developed in the engine via the propeller shaft to the propeller in water. 

 

The distance or forward motion depends mainly on the propeller pitch which is 

defined as how far the propeller can travel for one revolution of the shaft. Propeller is a 

type of a fan that transmits power by converting rotational motion into thrust. A pressure 

difference is produced between the forward and the rear surfaces of the air foil-shaped 

blade, and a fluid such as air or water is accelerated behind the blade.Lot of research is 

going on to minimize the various parameters of the propeller. 
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Ishiodu Anthony et al. [1] focused on the design procedure of four bladed marine 

propellers with specific interest on engines with 85Bhp and ship speed of 30 knots. The 

design and analysis of fixed pitch propeller of a ship is made and a step by step design 

procedure for a 4-bladed propeller has been outlined in this work. 

 

The result of the work thus shows that for a propeller with Blade area ratio of 0.55, 

the open water efficiency is 73%. This means that irrespective of the initial cost of design 

and manufacturing this type of propeller, the development of maximum efficiency should 

be the pursuit of the designer, the manufacturer and the user. 

 

Ganesh et al. [2] made a modelling and analysis of propeller blade to withstand the static 

loads for Aluminium alloy and Fibre reinforced composites materials. The present work 

carries out the structural analysis of a carbon fibre reinforced plastic (CFRP) propeller 

blade which proposed to replace the aluminium propeller blade and it was observed that 

maximum displacement for composite propeller is less than the aluminium propeller. 

 

The natural frequencies of aluminium and composite propeller were compared and 

found that aluminium propeller is 9 % more than the composite propeller. The weight of the 

composite propeller is 42% less than the aluminium propeller. 

 

BhanuPriya et al. [3] modelled and designed the propeller blade by using CATIA V5 

R19and analysis is made by ANSYS12.0 to withstand the static and dynamic load. The 

study is made for two different materials such as Aluminium and Composite. The 

deflection for composite propeller blade was found to be around 0.142 mm for all layers 

which is much less than that of aluminium propeller i.e. 0.181 mm, which shows composite 

materials is much stiffer than aluminium propeller. 

 

The natural frequency of composite propeller is 150% more than that of aluminium 

propeller and the max normal stresses of aluminium propeller are 87% higher than the 

composite propeller. The von- mises stresses are 50% higher in aluminium propeller than 

that of the composite propeller. 
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Pavan Kishore et al. [4] investigated that the composite materials are much stiffer than 

NAB material for propeller blade of an underwater vehicle. Analysis is made by using 

ANSYS. 

 

The deflection for composite propeller blade was found to be around 0.897 mm for 

all layers which is more than that of NAB propeller i.e. 0.597 mm, 

 

Suneetha et al. [5] made design by using CATIA and analysis by ABAQUS of a surface 

propeller using FEM. The geometric shape and its surface finish will decide the efficiency 

of the propeller. The material used is carbon UD and aluminium. 

 

The von-mises stress for aluminium is 92.642 N /mm
2
 and deformation is 0.496mm 

where as for composite 55.585 N/mm
2
 and deformation is 0.297mm.They concluded that 

carbon UD/epoxy material can give a better performance with respect to the conventional 

material. 

 

Mohammed Ahmed khan et al. [6] design and dynamic analysis of a propeller of ship 

made by using FEA. Propeller with conventional isotropic materials creates more vibration 

and noise in its rotation. In current years the increased need for light weight structural 

element with acoustic insulation has led to use of fibre reinforced multilayered composite 

propeller. 

 

The work is to carry out the dynamic analysis of aluminium and composite material, 

which is a combination of Glass Fibre Reinforced Plastics (GFRP) and Carbon Fibre 

Reinforced Plastics (CFRP). The deflection for composite propeller blade was found to be 

around 0.5 mm for all layers which is much less than that of aluminium propeller i.e. 

6.883mm, which shows composite materials is much stiffer than aluminium propeller. 

 

Praveen Kumar Surisetti et al. [7] 

reinforced plastic (CFRP) propeller 

propeller blade. 

 

Carried out the structural analysis of a carbon fibre 

blade which proposed to replace the Aluminium 
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The propeller blade is modelled and designed in CATIA to withstand the static 

loads for both aluminium and carbon fibre reinforced plastic materials and concluded that 

Composite propellers have more advantages over the conventional metallic propellers. 

 

VidyaSagar et al. [8] made solid model of propeller using CATIA V5 R17. 

Tetrahedral mesh is generated by using HYPER MESH. Static, Eigen and frequency 

responses analysis of both aluminium and composite propeller are carried out in ANSYS. 

 

The deflection for composite propeller (combination of GFRP-Glass Fibre 

Reinforced Plastics and CFRP-Carbon Fibre Reinforced Plastics materials) blade was found 

to be around 0.5mm for all layers which is much less than that of aluminium propeller i.e. 

6.883mm, which shows composite materials is much stiffer than aluminium propeller. 
 
 

SCOPE OF THE LITERATURE  

The investigation on the existing Patrolling vessel reviews the following drawbacks such as 

high investment cost, high usage of manpower for patrolling. Marine propellers, although 

submerged in water aft of the ship, form an integral part of a ship and play a vital role in ship 

propulsion. Much has been said and published on the development of the marine propeller 

from the time of antiquity to the present age, but there is more to be done. The movement of a 

ship through water is achieved by the power so developed in the engine via the propeller shaft 

to the propeller in water. 

OBJECTIVE OF LITERATURE 

To understand the modelling and analysis of water jet propulsion system to provide detail 

understanding of complicated three-dimensional viscous flow phenomenon including 

interactions of intake duct, impeller, stator and contracted discharge nozzle. 
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CHAPTER-3  

DESIGN OF THE SHIP 



 

3. DESIGN OF THE SHIP 
 

3.1 DESIGN THEORY 
 

3.1.1 DESIGN PROCESS 
 

There are three stages in the design procedure of the prototype to be made which 

constitute the following: 
 
                  Concept design 

 Requirement of the ship 

 Load carrying capacity of the ship


 Dimension parameter of the ship ex: Length, Breadth and 
Draft In concept design, based on the customer 
requirement use are arriving at length, breadth and depth 
of ship.



 

                  General Arrangement of ship 
 

-Profile view (Longitudinal view) 
 

-Plan view (Lateral view) 
 

-Sectional view (Transverse view)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 3.1: DIFFERENT VIEWS OF SHIP  
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 Functionality Design
 

Calculations to be done to design a ship 
 

-Tank capacity calculations 
 

-structural calculation 
 

-stability calculation 
 

-thrust calculation 
 

-flow calculation 
 

-powering calculation 
 

-water jet calculation 
 

-Efficiency calculation 
 
 
 

 Detailed Design
 

Internal structure of the ship of manufacturing  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 3.2: DETAILED DESIGN OF BOAT  
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3.1.2 CONDITIONS OF SEA 

 

Manoeuvring: Motion of a ship when in the 

absence of sea excitations (motions results 

from control surface deflections). 

 
 
 

 

Fig 3.3: MANEUVERING  
 

 

Sea keeping: Motion response of ships results 

from excitation Forces in the sea such as 

waves. The ability of a vessel to withstand 

rough conditions at sea. 

 
 

 

Fig 3.4: SEA KEEPING 

 

SEA SCALE CHART:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

TABLE2: SEA STATE CHART  
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3.1.3 STABILITY OF THE SHIP 

 

 Stability:
 

A floating body reaches to an equilibrium state, if 
 

1) Its weight = the buoyancy 
 

2) The line of action of these two forces becomes collinear. 

The equilibrium: stable, or unstable or neutrally stable. 

 

 Stable equilibrium: if it is slightly displaced from its equilibrium 
position and will return to that position.




 Unstable equilibrium: if it is slightly displaced from its equilibrium 
position and tends to move farther away from this position.




 Neutral equilibrium: if it is displaced slightly from this position and 
will remain in the new position.







 Motion of a Ship:
 

6 degrees of freedom 
 

- Surge 
 

- Sway 
 

- Heave 
 

- Roll 
 

- Pitch 
 

- Yaw  
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Fig 3.5: GYROSCOPIC COUPLE FORCES ON SHIP  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 3.6: EFFECT OF COUPLE ON SHIP  
 

 Table 3: GYROSCOPIC MOMENTS  

 Axis  Translation Rotation 

       

X  Longitudinal  Surge Roll S.  NS.  US 

   Neutral S.    
       

Y Transverse  Sway Pitch S. 

   Neutral S.    
       

Z  Vertical  Heave   S. Yaw NS 

   (for sub,    

   N.S.)    
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3.2 DESIGN SPECIFICATIONS OF THE PROTOTYPE 

 

3.2.1 DEFINITION (TERMINOLOGY): 
 

 Principal Dimensions (length, breadth, depth etc) -Length.
 

 

 FP –Forward perpendicular (vertical line through intersection of stem and 

waterline).


 AP –Backward perpendicular (vertical line through the centre of 

rudderpintle)


LOA – Overall Length 


LWL – Waterline Length (calculation length) 
 
 
 

3.2.2 PRINCIPAL DIMENSIONS: 
 

-Breadth, depth & draft. 
 

 Breadth (molded)  (inside of plate on one side to another side)


 Breadth maximum


 Depth (measured at midship)


 Camber – the rise of the deck at the centreline.  2% of breadth


 Bilge radius


 Rise of Floor
 

 Flat of keel (thicker plate)  
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Fig3.7: AFT SECTIONAL VIEW 
 

• If W.L. is parallel to the baseline (keel line), the ship is floating evenly. 
 

• If not parallel, the ship has a trim. 
 
 
 
 
 

 

• Free board (F.B) is the distance measured downwards from the deck to the L.W.L. 
 

• Usually F.B. is minimum at mid ship 
 

• Minimum F.B is required by International Law.  
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3.2.3 DIMENSIONAL SPECIFICATIONS OF THE VESSEL 
 

 The Principal Dimensions of the Vessel are as follows:


 

Length Overall 51.15 m 

Length Hull 48.0 m 

Length Waterline 44.0 m 

Chine Beam 7.91 m 

Displacement tested 275 tones 
 

 

The Fast Speed Craft Prototype considered for the project is scaled to 

model of 1:20. 

 

 The Principal Dimensions of the prototype are as follows:


 

Length Overall 
 

Length Hull 
 

Length Waterline 
 

Draft height 
 

Chine Beam 

 

7 feet 2 inches (2.2 m) 
 

1 foot 8 inches (55 cm) 
 

7 feet 1 inch (2.16 m) 
 

20 cm 
 

1 feet 1inch (35 cm) 
 
 

 Parameters of the Prototype / Prototype Plan


 

Speed - 34 knots scaled down to 6.81 knots ~12 km/h 
 

Turning Radius -3* L = 3 * 8 feet = 7 meters approx 
 

Thrust Required -275 KN 
 

Endurance – 4hours @ 85% discharging efficiency 
 

RC max Range - 1 Km to 2km 
 

Solar Cell - 400*300mm size -10 W solar panel 
 

Battery Capacity - 7.0A/H 1battery 
 

Power of the motor – 0.3 HP  
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CHAPTER-4 
 

PROPELLER AND ENCLOSURE DETAILS



 4. PROPELLER


 

The propeller is 6 blade contra rotating propeller with diameter 690mm and skew angle 

of 30 deg seated in enclosure. 

 

Propeller clearance: - 30mm from enclosure.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 4.1: PROPELLER 
 

 

 

 

 

 

 

 

 

  
 
 
 
 
 
 
 
 
 
 

 

Dept. of Mechanical Engineering, ANITS Page 25 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig 4.2: ELBOW  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 4.3: ELBOW NOMENCLATURE  
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       NPS 

            
          O D 
             D 

 
90 deg Long         
Rad 
Centre to End 
        A 

 
45 deg Long 
Rad 
Centre to End  
          B 

 
90 deg 
    3D 
Centre to End 
          A 

 
45 deg 
   3D 
Centre to End  
        B 

 
1/2 

 
21.3 

 
38 

 
16 

 
-- 

 
-- 

 
3/4 

 
26.7 

 
38 

 
19 

 
57 

 
24 

 
1 

 
33.4 

 
38 

 
22 

 
76 

 
31 

 
1.25 

 
42.2 

 
48 

 
25 

 
95 

 
39 

 
1.5 

 
48.3 

 
57 

 
29 

 
114 

 
47 

 
2 

 
60.3 

 
76 

 
35 

 
152 

 
63 

 
2.5 

 
73 

 
95 

 
44 

 
190 

 
79 

 
3 

 
88.9 

 
114 

 
51 

 
229 

 
95 

 
3.5 

 
101.6 

 
133 

 
57 

 
267 

 
111 

 
4 

 
114.3 

 
152 

 
64 

 
305 

 
127 

 
5 

 
141.3 

 
190 

 
79 

 
381 

 
157 

 
6 

 
168.3 

 
229 

 
95 

 
457 

 
189 

 
8 

 
219.1 

 
305 

 
127 

 
610 

 
252 

 
10 

 
273 

 
381 

 
159 

 
762 

 
316 

 
12 

 
323.8 

 
457 

 
190 

 
914 

 
378 

 
14 

 
355.6 

 
533 

 
222 

 
1067 

 
441 

 
 
 
 
 

                                       TABLE 4: UNIVERSAL ELBOW DIMENSIONS 
 

 

 O-RING SEAL


 

 

This is enclosed with washer which is used for the manufacturing of the seal which 

is made in the stepped shaft & which seals the elbow & shaft assembly. 

 

It is an alternative for stern tube in marine propulsion system.  
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4.  PROPELLER  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 4.4: PROPELLER AND PROPELLER SHAFT 

 

4.1 TYPES OF PROPELLERS: 
 

The ship propellers are basically two types 
 Screw Propeller




 Contra-rotating Propeller


 

Screw propeller: 

 

The concept of screw propeller dates back to the 950 BC to the mid-17th century, 

the raising of steam engines contributed to valuable use of screw propellers and transform 

to marine propeller. 

 

Nevertheless, the screw propeller is still considered as a second mover to the paddle 

wheel at this time. The acknowledgment for the invention of the modern style propeller 

goes to Smith and Eriksson who acquired patents in 1836 for screw propellers. 

 

The final step to what is now recognizable as a screw propeller is made by George 

Renee’s combined the ideas of increased pitch, multiple blades, and minimum convolutions 

called as Conidial propeller, patented in 1840 (Taggart,1969). 
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Screw propellers installed in the late of the 19th century lacked sophistication, but 

their performance exceeded all other devices conceived up to that time. During 1880 to 

1970 Basic shape of propellers remained unchanged. Ever since, marine propeller 

technology has made some advancements toward greater efficiency, more reliable design, 

better performance, improved materials, and cavitations resistance. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig.4.5 SCREW PROPELLER 

 

Marine engineers are still looking for new developments of unconventional 

propellers to improve the propeller efficiency and consequently the total ship fuel 

consumption. Among these new developments count up the 

 

 Controllable  pitch propeller (CPP)


 Skewback propeller


 ducted propeller


 Cycloidal propellers


 water jet propulsion, and


 podded and Azimuth podded propulsion systems. 
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Contra-rotating propeller: 

 

The concept of having two consecutive propellers behind each other, rotating in 

different directions is not new. In fact, this concept is as old as the screw propeller itself, as 

John Ericsson's patent of 1836 included single, twin, as well as contra-rotating propellers 

(John Ericson RINA affairs, 2004). Although the high efficiency obtained with contra-

rotating propellers has long been known, until fairly recently material technology and the 

need for long concentric shafts running in different directions made the concept both 

technically and economically unfeasible. 

 

However, in the mid 1980's contra-rotating propellers were successfully introduced 

in azimuth thrusters for, utilizing the short propeller shaft and bevel gear. In the late 1980’s, 

a distinct concept has made its way into the marine world. This new concept is referred to 

as podded propulsion and is distinguished from the original thruster in that its prime mover 

is an electric motor, situated in hub, directly driving propeller. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

FIG 4.6: CONTRA-ROTATING PROPELLER 

 

In the new millennium, efforts have been concentrated on development of a novel 

propulsion plant using the pod unit; it has been found that the "CRP-POD propulsion 
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System," combining the conventional propeller propulsion system with pod propulsion, is 

sufficiently economic and competitive in general merchant ships. The combined high 

efficiency of CRP and the excellent manoeuvrability of podded propulsions make the 

hybrid CRP system extremely attractive. 

 

The concept of contra-rotating propellers can be found also in aeronautics industry, 

Contra rotating aircraft propellers came into service at the end of WW II. This configuration 

offered a number of advantages including lower asymmetrical torque, higher efficiency, and 

smaller propeller disk (allowing shorter landing gear), (Carlton, 2008). But the complexity 

caused by the gearing mechanisms and the expensive maintenance costs resulted in the 

delay of contra-rotating propeller entering into service. Other fields the contra-rotating 

propellers are used are in the wind turbine field and in tide turbine for ocean energy 

utilization. 

 

4.2 GROUPS OF PROPELLERS: 

 

Propellers may be divided into the following two main groups, see also Fig. 7: 

 

 Fixed pitch propeller (FP-propeller) 
 

 Controllable pitch propeller  (CP-propeller)
 

Fixed pitch propeller: 

 

Propellers of the FP-type are cast in one block and normally made of a copper alloy. 

The position of the blades, and thereby the propeller pitch, is once and for all fixed, with a 

given pitch that cannot be changed in operation. This means that when operating in, for ex-

ample, heavy weather conditions, the propeller performance curves, i.e. the combination of 

power and speed (r/min) points will change according to the physical laws, and the actual 

propeller curve cannot be changed by the crew. Most ships which do not need a particularly 

good manoeuvrability are equipped with an FP-propeller. 
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Controllable pitch propeller: 

 

Propellers of the CP-type have a relatively larger hub compared with the FP-

propellers because the hub has to have space for a hydraulically activated mechanism for 

control of the pitch (angle) of the blades. The CP-propeller is relatively expensive, maybe 

up to 2-3 times as expensive as a corresponding FP-propeller. Furthermore, because of the 

relatively larger hub, the propeller efficiency is slightly lower. 

 

CP-propellers are mostly used for Ro-Ro ships, shuttle tankers, ferries and similar 

ships that require a high degree of manoeuvrability. For ordinary ships like container ships, 

bulk carriers and crude oil tankers sailing for a long time in normal sea service at a given 

ship speed, it will, in general, be a waste of money to install an expensive CP-propeller 

instead of an FP-propeller. Furthermore, a CP-propeller is more complicated, involving a 

higher risk of problems in service. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig 4.7: FIXED PITCH PROPELLERS AND CONTROLLABLE PITCH 
 

PROPELLERS  
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4.3 CLASSIFICATION OF PROPELLERS: 

 

Propeller blades are classified into 3 blade propellers to 4 blade propellers and 5 

blade propellers, the used propeller are 3 blades and 4 blade propellers. 

 

3 blade propeller: 

 

 The manufacturing cost is less than other types.


 Normally are of aluminium alloy.


 Gives a high speed performance.


 The acceleration is healthier than other types.


 Low speed handling is not resourceful.
 

4 blade propeller: 

 

 The manufacturing cost is higher than 3 blade propellers.


 Have better strength and durability.


 Gives a good low speed handling and performance.


 Has a better holding power in rough seas.


 4 blade propellers provide a better fuel economy than all the other types.
 

5 blade propeller: 
 

 Manufacturing cost is higher of all.


 Vibration is minimal from all the other types.


 5 blade propellers have better holding power in rough seas. 
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4.4  BLADE DESIGN:  

 

It is a common belief among propeller designers that the two design objectives are 

in contradiction to each other and consequently must be balanced to get a compromised 

design. But today some design features are available which can be applied to reduce the 

cavitation without sacrificing the efficiency. To build up a propeller blade, the complicated 

3-dimensional form is usually reduced into 2-dimensional elements which are then adjusted 

during the design process. 

 

A. BLADE AREA: 
 

The blade area should be kept as small as possible in order to reduce the friction 

losses when turning in the water, but to suppress the cavitations extension a certain area is 

needed. A measure of the blade area is the so-called “blade area ratio” (Ae/Ao) which is the 

ratio of all the blades compared to the area of the circle circumscribed by the propeller 

diameter. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Ae/Ao =0.40  Ae/Ao =0.55  Ae/Ao =0.70 

     
 

Fig 4.8: DIFFERENT BLADE AREA RATIOS  
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B.  BLADE SHAPE: 
 

The blade shape can be varied to even out the cavitation along radius and in the case 

of a nozzle propeller; it is advantageous to have wide-chord length at the tip (Kaplan 

shape). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 4.9: DIFFERENT SHAPES 

 

C. SKEW ANGLE: 
 

A powerful tool to suppress propeller induced noise and vibration is the application 

of skew. For modern CP propellers, the skew distribution is of the balanced type, which 

means that the blade chords at the inner radii are skewed (moved) forward, while at the 

outer radii the chords are skewed aft. By applying this type of skew it is possible to control 

the forces (spindle torque) needed for pitch settings. In most cases the blades will be 

balanced in such a way that the forces in the design pitch setting will be zero. Skew has the 

advantage of reducing the pressure impulses emitted from propeller to the hull surface to as 

much as one third of an un-skewed design without sacrificing the efficiency, which will 

remain unchanged. 
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No Skew  Low Skew  Medium  High Skew 
       

 

Fig 4.10: DIFFERENT SKEW ANGLES 
 
 
 

 

D. RAKE: 
 

The noise and vibration level in the aft ship depends on the distance between the 

propeller tip and hull surface - in particular exactly above and in front of the propeller. A 

way of increasing the distance is to rake (incline) the blade towards aft. As with skew the 

efficiency remains unchanged. However, the blade is exposed to higher stresses originating 

from an increase in the centrifugal forces which must be counteracted by an increase in 

blade thickness. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 4.11: RAKE ANGLE  
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                                                    FIGURE SHOWING THE ENCLOSURE  
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                                                  Performance Curve of blade impeller 
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4.5 WATERJET PROPULSION ASSEMBLY 
 
 
 
 

A water jet generates propulsive thrust from the reaction created when water is 

forced in a rearward direction. It works in relation to Newton's Third Law of Motion - 

"every action has an equal and opposite reaction". 

 

The original development of this principle can be traced back to 1661, when Too 

good and Hayes produced a description of a ship having a central water channel in which 

either a plunger or centrifugal pump was installed to provide the propulsion. 

 

In a boat hull the jet unit is 

mounted inboard in the aft section. 

Water enters the jet unit intake on the 

bottom of the boat, at boat speed, and is 

accelerated through the jet unit and 

discharged through the transom at a 
  

high velocity. The unit's thrust is 

mainly generated by momentum 

increase given in the water. 

 
 
 

 

Fig 4.12: WATER JET SYSTEM 

 

The picture below shows where water enters the jet unit via the Intake (A). The 

pumping unit, which includes the Impeller 
  

(B) and Stator (C), increases the pressure, 

or "head", of the flow. This high pressure 

flow is discharged at the nozzle (D) as a 

high velocity jet stream. The drive shaft 

attaches at the coupling (F) to turn the 

impeller. 

 

Fig 4.13: WATER JET UNIT  
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Steering is achieved by 

changing the direction of the stream of 

water as it leaves the jet unit. Pointing 

the jet stream one way forces the stern 

of the boat in the opposite direction 

which puts the vessel into a turn. 

 
 
 

 

Fig 4.14 WATER JET NOZZLE 
 
 

Reverse is achieved by lowering an astern deflector (E) into the jet stream after it 

leaves the nozzle. This reverses the direction of the force generated by the jet stream, 

forward and down, to keep the boat stationary or propel it in the astern direction. This 

means that the impeller is never reversed, so no reversible gearbox is needed for this 

system. 

Advantages




a. Very good manoeuvring 
 

b. Easy installation. No engine alignment. 
 

c. Quick braking and reversing mechanism 
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CHAPTER 5 

RESULTS AND DISCUSSIONS 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

5.1 DESIGN CALCULATIONS 

 

5.1.1 FLUID DYNANIMCS & STABILITY CALCULATIONS 
 

 

Buoyancy & Metacentric height calculations: 

 

Buoyancy:-  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Fig 5.1: METACENTRIC HEIGHT 

 

G---Centre of Gravity, B---Centre of Buoyancy 
 

M--- Transverse Meta centre, 
 

If M is above G, we will have a righting moment, and 
 

If M is below G, then we have a heeling moment. 
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Static Stability & Dynamical Stability 

 

Static Stability: Studying the magnitude of the righting moment given the inclination 

(angle) of the ship. (That is, the rolling velocity and energy are not considered.) 

 
 

Dynamic Stability: Calculating the amount of work done by the righting moment given 

the inclination of the ship. 
 

• Static Stability: 

 
1. The initial stability ( stability at small inclination) 

 
2. The stability at large inclinations. 

 

 

• The initial stability: studies the right moments or right arm at small inclination 
 

angles (< 5 degree). 
 

The stability at large inclination (angle): computes the right moments (or right arms) as 

function of the inclination angle, up to a limit angle at which the ship may lose its stability. 

 
 

Initial stability 
 

• Righting Arm: A symmetric ship is inclined at a small angle dΦ. C.B has moved 

off the ship’s centreline as the result of the inclination. The distance between the 

action of buoyancy and weight, GZ, is called righting arm. 
 

• Transverse Meta centre: A vertical line through the C.B intersects the original 

vertical centreline at point, M. 
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Fig 5.2: STABILITY CONDITION  
 
 
 
 

META-CENTRE 

 

 It is defined as the point about which a body starts oscillating when the body is tilted by a 

small angle. 

 It is the point at which the line of action of force of buoyancy will meet the normal axis of 

the body when the body is given small angular displacement. 

                                                                                                       

META-CENTRIC HEIGHT 

 

 It is the distance between the meta-centre of floating body and centre of gravity. 

 We can find this height by following methods:- 

Analytical Method 
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5.1.2   WATERJET CALCULATION: 
 

CALCULATIONS OF WATERJET PROPULSION SYSTEM: 
 

Water jet propulsion system has three main components: Inlet, Pump and Nozzle. Sea water 
 

Enters the system with the velocity  and leaves it with a different velocity . The 

mass flow rate of the water through the water jet is given by 
 
 
 

 

= 1000 * (π/4) * 0.712 * 13.1 
 

= 5186054 kg/s. 

 

Where and are the area of nozzle outlet and density of water, respectively. 

 

The thrust produced by the system is equal to the rate of change of momentum:  
 
 
 
 

 

=1000 *( π/4) * 0.712* 13.1(13.1-6.5) 
 

= 34231.17 N. 
 

The effective propulsion power delivered by the system is given by  
 
 

 

= 34231.17 * 17.5  
= 599.0 kW  

 
 
 
 
 
 
 
 
 
 

 

Fig 5.3: PRESSURE HEAD IN WATERJET  
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The energy equation between points 1 and 2 can be written as  
 
 
 

 

Where 

 

: Pump head 

 

: Vertical distance between inlet and outlet 
 

: Total head loss. 
 

 

(0.15/1000*9.81) + (6.52/2*9.81) +710= (0.5/1000*9.81) + (13.1/2*9.81) 

 

+1000+hloss 

 

hloss= -296.5. 

 

The jet efficiency is defined as  
 
 
 
 

 

=599/599+296.5 

 

= 81.46% 

 

This indicates that the jet efficiency is equal to the ratio of useful power to the total 

power absorbed by the system. 

 

Because of the effect of hull and geometry of the inlet duct, the inlet velocity is different 

from ship velocity. Hence, the inlet velocity ratio is defined as follows: 
 
 
 
 

 

=6.5/17.5 

 

IVR =0.371  
 
 
 

Dept. of Mechanical Engineering, ANITS Page 45 



 

Head losses in the duct inlet and outlet are functions of squared velocity  
 
 
 
 

 

=(0.25*6.52)/(2*9.81) 
 

hinlet=0.53 m 
 
 
 
 
 
 

 

= ( 2.8*17.52) / 
(2*9.81) h = 24.49 m 

 
 
 
 

Power input to the system (received by the pump) is given by  
 
 
 
 
 

 

= 5186.54[0.5(13.1
2
 – 6.5

2
) 

+9.81(986+296.5) Ppump = 88091.32 kW. 
 
 

Where is the vertical distance between the outlet nozzle and the water line? By 

separating system losses and applying loss coefficients, we obtain 
 
 
 

 

= (5186.54/2) [13.1(1+2.8)-(1-0.25) (1-0.5)2* 17.5 +2*9.81*986 
 

= 69078 kW.  
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Assuming the velocity ratio as  

 

=17.5/13.1 

 =1.33
 
 

 

Now the jet efficiency can be written as  
 
 
 
 
 

 

= 2(1.33)[1-(1-0.5)1.33] 
 

1+2.8-(1-0.25)(1-0.5)2*1.332+(2*9.81*986*1.332/17.52) 
 

= 77.34%  
 

 

The efficiency of hull is given by  
 
 

 

= (1-0.6)/ (1-0.5) 
= 80%  

 

                 

 

The total efficiency is defined by the following equation:  
 
 
 

 

= 0.8 * 0.7734 * 0.81 

 

=49%  
 

             The total efficiency that we get finally = 49% 

  
  Hence the total efficiency = 49% and Efficiency of the hull= 80%. 

 
 
 
 
 

 

Dept. of Mechanical Engineering, ANITS Page 47 



 

5.2 3-D MODELLING OF THE SHIP 

 

5.2.1 ABOUT SOFTWARE 

 

CATIA - which stands for Computer Aided Three-dimensional Interactive Application 

is the most powerful and widely used CAD (computer aided design) software of its kind in 

the world. CATIA is owned/developed by Dassault Systems of France and until 2010, was 

marketed worldwide by IBM. 

 

CATIA plays a major role in the design process. Architects are now using CATIA. The 

great Guggenheim Museum in Spain, considered an architectural masterpiece, was 

designed using CATIA. 

 

 

CATIA is used by the automotive and aerospace industries for automobile and aircraft 

product and tooling design. There are thousands of companies the world over using 

CATIA. For every company that uses CATIA for product design, there are hundreds of 

suppliers to those companies that also use CATIA. 

 
 

CATIA is found in a variety of industries throughout the world. Some of these 

industries include; Aerospace, Appliances, Architecture, Automotive, Construction, 

Consumer Goods, Electronics, Medical, Furniture, Machinery, Mould and Die, and 

Shipbuilding. 

 

 

CATIA has played a major role in NASA's design of the Space Shuttle. The military - 

working with private industry - - uses CATIA for the design of "jet-fighter" aircraft, aircraft 

carriers, helicopters, tanks and various other forms of weaponry. 
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5.2.2 CATIA MODELLING 

 

  Fig 5.4:   IMPELLER (3D Figure) 

 

 

 
Fig 5.5:  WATERJET  CASING (3D Figure) 

 

                                           
 
 
 

 

Dept. of Mechanical Engineering, ANITS Page 49 



 
Fig 5.6: FINAL CATIA ASSEMBLY .Cat Product 

 

 

Steps involved: 

 

1. Click on all programs>click on CATIA V5 R20. Then a new issue means window is 

opened titled CATIA V5 R20. 
 

2. Click on start>go to mechanical design>click on part design. Then a dialog box 

appears where a name is given to the part. 
 

3. Click on XY plane & then click in sketch tool. 
 

4. Draw each part (Gear, motor, shaft, pillow block (UCP 205), bush and propeller) by 

using various tools, profile etc. 
 

5. Save the models as files.CATPart in specified location. 
 

6. Go to Start > Mechanical design > Click on Assembly design. Assembly 

Workbench will be opened. 
 

7. In the Product Structure Tools > Select Existing Component and click on Products > 

Select the saved files.CATPart file and click on Open. Components will get 

imported to Assembly module. 
 
 
 
 

 

Dept. of Mechanical Engineering, ANITS Page 50 



 

8. Go to Constraints toolbar > Click on Coincidence constraint > Select axis of shaft 

and gear > Click on Update. 
 

9. Go to Constraints toolbar > Click on Contact constraint > Select the contact surfaces 

of models and click on Update. 
 

10. If required move or rotate the parts along the axis using move tool. 
 

Result: 
 

11. The Modelling and Assembly of the propulsion system is successfully done.  
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5.3  ANALYSIS  OF  THE  SHIP  PROPELLER  WITH  ENCLOSURE 

 

ANSYS INTRODUCTION 

 
Ansys, Inc. is a public company based in Canonsburg, Pennsylvania. It develops and markets 

engineering simulation software. Ansys software is used to design products and semiconductors, as 

well as to create simulations that test a product's durability, temperature distribution, fluid 

movements, and electromagnetic properties. 

Ansys develops and markets finite element analysis software used to simulate engineering problems 

.The software creates simulated computer models of structures, electronics, or machine components 

to simulate strength, toughness, elasticity, temperature distribution, electromagnetism, fluid flow, 

and other attributes  Ansys is used to determine how a product will function with different 

specifications, without building test products or conducting crash tests.] For example, Ansys 

software may simulate how a bridge will hold up after years of traffic, how to best process salmon 

in a cannery to reduce waste, or how to design a slide that uses less material without sacrificing 

safety. 

ANSYS CFX is a computational fluid dynamics software that is used by engineers for design and 

analysis of CAD models. It can simulate fluid flows in a virtual environment and is frequently used 

in the aerospace, automotive, and oil and energy fields. 

ANSYS CFX is especially attuned to solving problems in turbo machinery and conjugate heat 

transfer, but it can solve any CFD problem, covering compressible and incompressible flow; ideal 

and real gas equations of steady and unsteady flow; subsonic, transonic, and supersonic flow; 

coupled convection; and conduction. 
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5.3.1 FLOW ANALYSIS 

 

 
 

Fig 5.7 PRESSURE OUTLET VARIATION  
 

                                                      Fig 5.8  SUPERFICIAL VELOCITY STREAM LINE 
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Fig 5.9 VELOCITY VARIATION ALONG A PLANE 
 

 
 

 Fig 5.10 VELOCITY VARIATION  
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Fig 5.11 VELOCITY STREAM LINE 

 
Fig 5.12VARIATION OF VELOCITY FROM INLET TO OUTLET  
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Fig 5.13 VELOCITY STREAM LINE 

 
 

5.3.2 CAVITATIONS ANALYSIS 
 

Water will boil at room temperature if the pressure is low enough. In fact, the 

pressure has to be very low, about 2% of standard atmospheric pressure at sea level. 
 
 

 

Just like a wing generating lift, marine propellers  

use pressure differences across their blades to generate  

thrust.  The pressure distribution on a propeller  blade  

depends on its shape and how that shape influences the  

speed of the water  flowing around the blade. As the 
 

Fig 5.14: SCREW PROPELLER  

flow speeds up, the pressure drops and conversely when  

the flow slows down, the pressure rises.  
 
 

Thus the blade is shaped to promote higher speed on the forward or suction side 
and lower speed on the aft or pressure side. If the blade shape is too aggressive, very 
low pressure can result. Indeed, this pressure can be low enough to reach the boiling 
point of water which then leads to cavitations. 
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. 
 

The pressure plots show a problem with this propeller near the leading edge of the blades. 

There is a narrow band of high pressure (red area, left) on the suction side and a narrow 

band of low pressure (blue area, right) on the pressure side. This is undesirable since it 

means that the leading part of each blade is generating thrust in the wrong direction! 

 

There is one catch though: these pressure plots do not include the effect of cavitation. The 

dark blue areas show pressure below the vapour pressure of water which means cavitation 

should occur in those areas. By turning on the cavitation model, the phase change from 

water to water vapour can be captured. This is shown in the figure at the right where the 

pink area represents the interface between water and water vapour. The remarkable 

accuracy of this cavitations prediction can be seen by comparing the areas of erosion on the 

actual propeller (left) with CFD results (right). 

 

The model shows that sheet cavitations are occurring near the leading edge on the pressure 

side of the blades. This indicates that effective angle of attack near the leading edge must 

be negative, resulting in an area of very low pressure on the aft side of the blade. 

STEPS INVOLVED IN CAVITATION ANALYSIS: 

 Geometry


 

1. Open ANSYS Workbench 18.0 > Drag and Drop Static Fluid CFX into the project 

schematic. 
 

2. Right click on Geometry > Import Geometry > Select the file “propeller of VIGT-

18.igs” in the saved location > Click on Update. 
 

3. Now Double click on geometry, and then design modeller window will open. Go to 

Tools > Enclosure > In the details toolbar, select uniform cushion > select preference 

as cylinder enclosure and give the value as 30mm front and 25 mm back > Click on 

Generate > Update the geometry and exit design modeller window. 
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                                        Fig 5.15:    IMPORTED IMPELLER IN ANSYS WORKBENCH 
 
 
 

 
                    Fig 5.16:   IMPORTED ASSEMBLY MODEL OF IMPELLER AND ENCLOSURE WITH 
                                                      TRANSPARENCY IN ANSYS WORKBENCH 
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Fig 5.17 IMPORTED GEOMETRY OF PROPELLER MODEL WITH ENCLOSURE 
IN ANSYS WORKBENCH 

 

 
Fig 5.18 IMPORTED GEOMETRY OF PROPELLER MODEL IN 

ANSYS WORKBENCH 
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 Meshing


 

4. Right click on mesh > Click on Edit. The meshing window will open. 
 

5. Right Click on Mesh in the specification tree > in the details toolbar, give the 

following inputs and click on Generate Mesh. 

 

Physics Preference 
 

- CFD 

 

Solver Preference 

 

- Fluent 

 

Relevance Centre 

 

- Fine 

 

Advanced Size function 

 

- Proximity and Curvature 

 

Smoothing 

 

- High 

 

6.Now Select the individual faces of the enclosure, right click on the face > Click on Create Named 

Selection > select the face and give the names as inlet, outlet and wall > Click on Update Mesh. 

 

 

Fig 5.19 IMPELLER   MESHING 
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Fig 5.20 ENCLOSURE   MESHING 

 

 

 
Fig 5.21 SECTIONAL VIEW OF MESHED WATERJET 

ASSEMBLY 
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Fig 5.22 MESHED   WATERJET   ASSEMBLY 

 

 

 Setup




7. Double Click on Setup > Select Double Precision in Options > Serial in processing 

Options > Click on OK. 
 

8. Create domain structure & generate the domains as per named sections> select the 

solid component as blade > and liquid profile as inlet , wall,etc 
 

9. Select the blade profile and give the required rpm> 1440 rpm clockwise > then click on 

the equation method> use Rayleigh Placket equation > click OK. 
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 SOLUTION


 

10. Wait until the geometry is loaded and in the Solution Setup > Go to General > Click on 

Check and Report Quality. 
 

11. Go to Materials > Select water > Click on Edit > Verify the default inputs and click 

OK. 
 

12. Go to Boundary Conditions > Select inlet zone > Set type as velocity-inlet and click on 

Edit > Give Velocity Magnitude as 6m/s >Go to outlet zone >set velocity –outlet > 

magnitude as 8m/s> Click on OK. 
 

13. Go to Solution Initialization > Select Standard Initialization > Compute from inlet > 

Click on Initialize. 
 

14. Go to Run Calculation > Give the number of Iterations as 20 > Profile update and 

reporting interval as 1 > Click on Calculate. 
 

15. Wait until a information is displayed saying calculation complete. Click on OK and 

terminate the solution workbench. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig 5.23: SOLUTION ITERATION  
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 5.3.3 PLOT RESULTS


 

16. Open Results Window > Enable contact region, disable Wireframe > Click on Insert 

Streamline > give name as streamline 1 > Click on OK. 
 

17. In the details toolbar, give the following inputs and click on OK. 
 

Domains - All Domains 
 

Start from - Inlet 
 

Sampling - Equally spaced 
 

No of points - 150 
 

Variable - Velocity 
 

Direction - Forward and Backward 
 

 

18. We can visualize the streamlines showing varying velocities over the propeller body 

from inlet to outlet as shown in the figures. Similarly, other parameters like pressure 

and temperature variations can also be studied. 

 

 
 

Fig 5.24 PRESSURE OUTLET VARIATION  
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Fig 5.25 SUPERFICIAL VELOCITY STREAM LINE 

 
 

 
  

Fig 5.26 VELOCITY VARIATION ALONG A PLANE 
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Fig 5.27 VELOCITY VARIATION  

 
 

 
  

Fig 5.28 DEPECTING CAVITATION EFFECTS ALONG WITH STREAM LINES 
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Fig 5.29VELOCITY STREAM LINE 

 

 
Fig 5.30 VARIATION OF VELOCITY FROM INLET TO OUTLET  
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                                                              Fig 5.33 CAVITATION ANALYSIS 
 
 
 
 

 
 
 

Fig 5.32 VELOCITY STREAM LINE 

 

 
Cavitation and Flow analysis reports are given in appendix I and appendix II  
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CONCLUSIONS 
 
 
 
 

1) Design and Analysis of a water jet propulsive patrolling vessel made with six bladed 

propellers with optimum rake angle and geometry in Order to obtain maximum performance out of 

the blade design and to minimise cavitation  

 

2) Effect on blades, cavitation decreases with varying blade area. It is observed that the Ship is 

not proving the speed due to increased displacement and cavitating impeller. 

 

3) To produce the required thrust with the existing ship conditions. Improved blade has the 

capability to work at maximum thrust with minimised cavitation effect. 

 

4) The hydrodynamic pressure changes, detailed flow analysis, velocity stream flow and 

cavitation analysis were done with a 6 bladed Impeller using CFX. 

 

5) Improved propulsive efficiency with respect to change in blade rake angle can be achieved 

with this analysis. 

 

6) From calculations 80% Hull Efficiency and 49% Overall efficiency is proved. 

 

7) Pressure variation, velocity variation with cavitation effects of six numbered blades with 

improved efficiency is achieved. 

 

 

 
 
` 
 
 
 
 
 
 
 
 
 
 
 
 
 
    
 

 

Dept. of Mechanical Engineering, ANITS                                                                     Page 69 
 

 



REFERENCES 

 
1.Ishiodu Anthony, Williams Ekwere, Ezenwa Ogbonnaya and Kuvie Ejabefio " Design Procedure 

of 4-Bladed Propeller" African journal of industrial and academic research, vol8 sep 2013. 

 

 2. Tadashi Taketani1 , Koyu Kimura1 , Satoko Ando1 , Koutaku Yamamoto “Study on 

Performance of a Ship Propeller Using a Composite Material” Third International Symposium on 

Marine Propulsors smp’13, Launceston, Tasmania, Australia, May 2013. 

 

3.M.M.Gaafary, H.S.Kilani "optimum design of B-series marine propellers " vol8 sep 2012. 

 

 4. Barru Harish , Kondapalli Siva Prasad “Static Analysis of 4-Blade Marine Propeller” stm 

journals , Volume 5, Issue 2 ,mar 2015. 

 

 5. Young YL, (2007), “Time-dependent hydroelastic analysis of cavitating propulsors”, Journal of 

Fluids and Structures, 23:269–295. 

  

6.Blasques, J.P., Berggreen, C. and Andersen, P. (2010). “Hydro-elastic Analysis and Optimization 

of a Composite Marine Propeller,” Marine Structures, 23, 22-38. 

 

 7.Boer de, A., Zuijlen van, A.H. and Bijl, H. (2007). “Review of coupling methods for non-

matching meshes,” Computer methods in applied mechanics and engineering, 196,1515-1525.  

 

8. Karl Randle and Peter Bull.march 2005, “Predictions of the Thrust and Torque Performance for 

two Propeller Blades Using Computational Fluid Dynamics” International Conference on marine 

CFD. 

 

9. JL.Reboud, 2006 “A Method to Predict Cavitation Inception Using LargeEddy Simulation and its 

Application to the Flow Past a Square Cylinder”, Institute of Fluid Mechanics, Technische 

Universität, Dresden, ASME, vol.128,2006.  

 

10. Sandor Bernad, “Numerical Analysis Of The Cavitating Flows”, Center of Advanced Research 

in Engineering Sciences, Romanian Academy, Timisoara Branch, Romania, 2006.  

 

11. Francesso Salvatore V.H and Accosta AJ 1973 “Viscous effects in the inception of cavitation on 

axisymmetric bodies,” ASME J. Fluids Eng., 109, pp.12-25. 

12. Gangler J-P, Burgers I. The combination of waterjet and refined propeller propulsion. Marine 

News. 1-2003:15-7. 

13. Watson DGM. Practical ship design. Elsevier Science; 1998. 

14.Carlton J. Marine propellers and propulsion. Oxford: Butterworth-Heinemann; 2007. 

15. Norbert Willem Herman Bulten, Numerical analysis of a waterjet propulsion system. 

Eindhoven, Netherlands: Eindhoven University of Technology, 2006. 

 

Dept. of Mechanical Engineering, ANITS                                                                     Page 70 



APPENDIX I 

FLOW ANALYSIS REPORT 

Date 

2018/04/11 18:00:02 

 

Contents 

1. File Report 

    Table 1  File Information for CFX 

2. Mesh Report 
    Table 2  Mesh Information for CFX 

3. Physics Report 

    Table 3  Domain Physics for CFX 
    Table 4  Boundary Physics for CFX 

4. User Data 

 

1. File Report 
Table 1.  File Information for CFX 

Case CFX 

File Path C:\Users\CADD\Desktop\waterjet anits_files\dp0\CFX\CFX\Fluid Flow 

CFX_002.res 

File Date 08 April 2018 

File Time 09:01:10 PM 

File Type CFX5 

File 

Version 

18.0 

  
 

2. Mesh Report 
Table 2.  Mesh Information for CFX 

Domain Nodes Elements 

casing 803212 4425557 

impeller 338216 1646149 

All Domains 1141428 6071706 

file:///C:/Users/student/Desktop/Report.htm%23SECTION1.
file:///C:/Users/student/Desktop/Report.htm%23TABLE1
file:///C:/Users/student/Desktop/Report.htm%23SECTION2.
file:///C:/Users/student/Desktop/Report.htm%23TABLE2
file:///C:/Users/student/Desktop/Report.htm%23SECTION3.
file:///C:/Users/student/Desktop/Report.htm%23TABLE3
file:///C:/Users/student/Desktop/Report.htm%23TABLE4
file:///C:/Users/student/Desktop/Report.htm%23SECTION4.


  
 

3. Physics Report 
Table 3.  Domain Physics for CFX 

Domain - casing 

Type Fluid 

Location B1243 

Materials 

Water 

     Fluid Definition Material Library 

     Morphology Continuous Fluid 

Settings 

Buoyancy Model Non Buoyant 

Domain Motion Stationary 

Reference Pressure 1.0000e+00 [atm] 

Heat Transfer Model Isothermal 

     Fluid Temperature 2.5000e+01 [C] 

Turbulence Model k epsilon 

Turbulent Wall Functions Scalable 

Domain - impeller 

Type Solid 

Location impeller 

Settings 

Domain Motion Rotating 

     Angular Velocity 9.3400e+02 [rev min^-1] 

     Axis Definition Coordinate Axis 

     Rotation Axis Coord 0.1 

Domain Interface - Default Fluid Solid Interface 

Boundary List1 Default Fluid Solid Interface Side 1 

Boundary List2 Default Fluid Solid Interface Side 2 

Interface Type Fluid Solid 

Settings 

Interface Models General Connection 

Mesh Connection Automatic 

  
 

Table 4.  Boundary Physics for CFX 

Domain Boundaries 



casing Boundary - inlet 

Type INLET 

Location inlet 

Settings 

Flow Regime Subsonic 

Mass And 

Momentum 

Normal Speed 

     Normal 
Speed 

9.0000e+00 [m s^-1] 

Turbulence Medium Intensity and Eddy Viscosity Ratio 

Boundary - Default Fluid Solid Interface Side 1 

Type INTERFACE 

Location F1188.1243, F1189.1243, F1190.1243, F1191.1243, 
F1192.1243, F1193.1243, F1194.1243, F1195.1243, 

F1196.1243, F1197.1243, F1198.1243, F1199.1243, 

F1200.1243, F1201.1243, F1202.1243, F1203.1243, 
F1204.1243, F1205.1243, F1207.1243, F1208.1243, 

F1210.1243, F1211.1243, F1212.1243, F1213.1243, 

F1214.1243, F1215.1243, F1216.1243, F1217.1243, 

F1218.1243, F1219.1243, F1220.1243, F1221.1243, 
F1222.1243, F1223.1243, F1224.1243, F1225.1243, 

F1226.1243, F1227.1243, F1228.1243, F1229.1243, 

F1230.1243, F1232.1243, F1233.1243, F1234.1243, 
F1235.1243, F1236.1243, F1237.1243, F1238.1243, 

F1239.1243, F1240.1243, F1241.1243, F1242.1243, 

F1255.1243, F1256.1243, F1257.1243, F1258.1243, 
F1259.1243, F1260.1243, F1261.1243, F1262.1243, 

F1263.1243, F1265.1243, F1266.1243, F1267.1243, 

F1268.1243, F1269.1243, F1270.1243, F1271.1243, 

F1272.1243, F1273.1243, F1274.1243, F1275.1243, 
F1276.1243, F1277.1243, F1278.1243, F1279.1243, 

F1280.1243, F1281.1243, F1282.1243, F1283.1243, 

F1284.1243, F1285.1243, F1286.1243, F1287.1243, 
F1288.1243, F1289.1243, F1290.1243, F1291.1243, 

F1292.1243, F1294.1243, F1295.1243, F1296.1243, 

F1297.1243, F1298.1243, F1299.1243, F1301.1243, 

F1302.1243, F1303.1243, F1304.1243, F1305.1243, 
F1306.1243, F1307.1243, F1308.1243, F1309.1243, 

F1310.1243, F1311.1243, F1312.1243, F1313.1243, 

F1314.1243, F1315.1243, F1316.1243, F1317.1243, 
F1318.1243, F1319.1243, F1320.1243, F1321.1243, 

F1322.1243, F1323.1243, F1324.1243, F1325.1243, 

F1326.1243, F1327.1243, F1328.1243, F1329.1243, 
F1330.1243, F1331.1243, F1332.1243, F1333.1243, 

F1334.1243, F1335.1243, F1336.1243, F1337.1243, 

F1338.1243, F1339.1243, F1340.1243, F1341.1243, 

F1342.1243, F1343.1243, F1344.1243, F1345.1243, 
F1346.1243, F1347.1243, F1348.1243, F1349.1243, 

F1350.1243, F1351.1243, F1352.1243, F1353.1243 



Settings 

Mass And 

Momentum 

No Slip Wall 

Wall 

Roughness 

Smooth Wall 

Boundary - outlet 

Type OUTLET 

Location outlet 

Settings 

Flow Regime Subsonic 

Mass And 

Momentum 

Normal Speed 

     Normal 
Speed 

1.5000e+01 [m s^-1] 

Boundary - wall 

Type WALL 

Location wall 

Settings 

Mass And 

Momentum 

No Slip Wall 

Wall 
Roughness 

Smooth Wall 

impeller Boundary - Default Fluid Solid Interface Side 2 

Type INTERFACE 

Location F391.499, F392.499, F393.499, F394.499, F395.499, 

F396.499, F397.499, F398.499, F399.499, F400.499, 
F401.499, F402.499, F403.499, F404.499, F405.499, 

F406.499, F407.499, F408.499, F409.499, F410.499, 

F411.499, F412.499, F413.499, F414.499, F415.499, 

F416.499, F417.499, F418.499, F419.499, F420.499, 
F421.499, F422.499, F423.499, F424.499, F425.499, 

F426.499, F427.499, F428.499, F429.499, F430.499, 

F431.499, F432.499, F433.499, F434.499, F435.499, 
F436.499, F437.499, F438.499, F439.499, F440.499, 

F441.499, F442.499, F443.499, F444.499, F445.499, 

F446.499, F447.499, F448.499, F449.499, F450.499, 

F451.499, F452.499, F453.499, F454.499, F455.499, 
F456.499, F457.499, F458.499, F459.499, F460.499, 

F461.499, F463.499, F464.499, F466.499, F467.499, 

F468.499, F469.499, F470.499, F471.499, F472.499, 
F473.499, F474.499, F475.499, F476.499, F477.499, 

F478.499, F479.499, F480.499, F481.499, F482.499, 

F483.499, F484.499, F485.499, F486.499, F488.499, 
F489.499, F490.499, F491.499, F492.499, F493.499, 

F494.499, F495.499, F496.499, F497.499, F498.499, 

F500.499, F501.499, F502.499, F503.499, F504.499, 



F505.499, F506.499, F507.499, F508.499, F510.499, 

F511.499, F512.499, F513.499, F514.499, F515.499, 

F516.499, F517.499, F518.499, F519.499, F520.499, 

F521.499, F522.499, F523.499, F524.499, F525.499, 
F526.499, F527.499, F528.499, F529.499, F530.499, 

F531.499, F532.499, F533.499, F534.499, F535.499, 

F536.499, F537.499, F539.499, F540.499, F541.499, 
F542.499, F543.499, F545.499 

Settings 

Heat 
Transfer 

Adiabatic 

Boundary - impeller Default 

Type WALL 

Location F544.499 

Settings 

Heat 

Transfer 

Adiabatic 
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1. File Report 
Table 1.  File Information for Copy of Fluid Flow CFX 

Case Copy of Fluid Flow CFX 

File Path C:\Users\CADD\Desktop\waterjet anits_files\dp0\CFX-1\CFX\Fluid Flow 

CFX_001.res 

File Date 10 April 2018 

File Time 05:44:58 PM 

File Type CFX5 

File 

Version 

18.0 

  
 

2. Mesh Report 
Table 2.  Mesh Information for Copy of Fluid Flow CFX 

Domain Nodes Elements 

casing 309844 1657171 

impeller 205477 1040227 

All Domains 515321 2697398 

  
 

3. Physics Report 
Table 3.  Domain Physics for Copy of Fluid Flow CFX 

Domain - casing 

Type Fluid 

Location B1243 

Materials 

Water 

     Fluid Definition Material Library 

     Morphology Continuous Fluid 

Water Vapour at 25 C 

     Fluid Definition Material Library 

     Morphology Continuous Fluid 

Settings 

Buoyancy Model Non Buoyant 



Domain Motion Stationary 

Reference Pressure 1.0000e+00 [atm] 

Heat Transfer Model Isothermal 

     Fluid Temperature 2.5000e+01 [C] 

     Homogeneous Model True 

Turbulence Model k epsilon 

Turbulent Wall Functions Scalable 

Domain - impeller 

Type Solid 

Location impeller 

Settings 

Domain Motion Rotating 

     Angular Velocity 9.3400e+02 [rev min^-1] 

     Axis Definition Coordinate Axis 

     Rotation Axis Coord 0.1 

Domain Interface - Default Fluid Solid Interface 

Boundary List1 Default Fluid Solid Interface Side 1 

Boundary List2 Default Fluid Solid Interface Side 2 

Interface Type Fluid Solid 

Settings 

Interface Models General Connection 

Mesh Connection Automatic 

  
 

Table 4.  Boundary Physics for Copy of Fluid Flow CFX 

Domain Boundaries 

casing Boundary - inlet 

Type INLET 

Location inlet 

Settings 

Flow Regime Subsonic 

Mass And 

Momentum 

Normal Speed 

     Normal 

Speed 

9.0000e+00 [m s^-1] 

Turbulence Medium Intensity and Eddy Viscosity Ratio 

Fluid Fluid 1 

     Volume 

Fraction 

Value 

     Volume 1.0000e+00 



Fraction 

Fluid vapour 

     Volume 
Fraction 

Value 

     Volume 

Fraction 

0.0000e+00 

Boundary - Default Fluid Solid Interface Side 1 

Type INTERFACE 

Location F1188.1243, F1189.1243, F1191.1243, F1192.1243, 

F1193.1243, F1194.1243, F1195.1243, F1196.1243, 

F1197.1243, F1198.1243, F1199.1243, F1200.1243, 
F1201.1243, F1202.1243, F1203.1243, F1204.1243, 

F1205.1243, F1207.1243, F1208.1243, F1210.1243, 

F1211.1243, F1212.1243, F1213.1243, F1214.1243, 

F1215.1243, F1219.1243, F1220.1243, F1221.1243, 
F1222.1243, F1223.1243, F1224.1243, F1225.1243, 

F1226.1243, F1227.1243, F1228.1243, F1229.1243, 

F1230.1243, F1232.1243, F1233.1243, F1234.1243, 
F1235.1243, F1236.1243, F1237.1243, F1238.1243, 

F1239.1243, F1240.1243, F1241.1243, F1242.1243, 

F1255.1243, F1256.1243, F1257.1243, F1258.1243, 
F1259.1243, F1260.1243, F1261.1243, F1262.1243, 

F1266.1243, F1267.1243, F1268.1243, F1269.1243, 

F1270.1243, F1271.1243, F1272.1243, F1273.1243, 

F1274.1243, F1275.1243, F1276.1243, F1277.1243, 
F1278.1243, F1279.1243, F1280.1243, F1281.1243, 

F1282.1243, F1283.1243, F1284.1243, F1285.1243, 

F1286.1243, F1287.1243, F1288.1243, F1289.1243, 
F1290.1243, F1291.1243, F1292.1243, F1294.1243, 

F1296.1243, F1297.1243, F1298.1243, F1299.1243, 

F1301.1243, F1302.1243, F1303.1243, F1305.1243, 
F1306.1243, F1307.1243, F1308.1243, F1309.1243, 

F1310.1243, F1311.1243, F1312.1243, F1313.1243, 

F1314.1243, F1315.1243, F1316.1243, F1317.1243, 

F1318.1243, F1319.1243, F1320.1243, F1321.1243, 
F1322.1243, F1323.1243, F1324.1243, F1325.1243, 

F1326.1243, F1327.1243, F1329.1243, F1330.1243, 

F1331.1243, F1332.1243, F1333.1243, F1334.1243, 
F1335.1243, F1336.1243, F1337.1243, F1338.1243, 

F1339.1243, F1340.1243, F1341.1243, F1342.1243, 

F1343.1243, F1345.1243, F1346.1243, F1347.1243, 

F1348.1243, F1349.1243, F1350.1243, F1351.1243, 
F1352.1243, F1353.1243 

Settings 

Mass And 

Momentum 

No Slip Wall 

Wall 
Roughness 

Smooth Wall 

Boundary - outlet 



Type OUTLET 

Location outlet 

Settings 

Flow Regime Subsonic 

Mass And 
Momentum 

Normal Speed 

     Normal 

Speed 

1.5000e+01 [m s^-1] 

Boundary - wall 

Type WALL 

Location wall 

Settings 

Mass And 
Momentum 

No Slip Wall 

Wall 

Roughness 

Smooth Wall 

impeller Boundary - Default Fluid Solid Interface Side 2 

Type INTERFACE 

Location F391.499, F392.499, F393.499, F395.499, F396.499, 

F397.499, F398.499, F399.499, F400.499, F401.499, 

F402.499, F403.499, F404.499, F405.499, F406.499, 
F407.499, F408.499, F409.499, F410.499, F411.499, 

F412.499, F413.499, F414.499, F415.499, F416.499, 

F417.499, F419.499, F420.499, F421.499, F422.499, 

F423.499, F424.499, F425.499, F426.499, F427.499, 
F428.499, F429.499, F430.499, F431.499, F432.499, 

F433.499, F435.499, F436.499, F437.499, F438.499, 

F439.499, F440.499, F441.499, F442.499, F443.499, 
F444.499, F445.499, F447.499, F448.499, F449.499, 

F450.499, F451.499, F452.499, F453.499, F454.499, 

F455.499, F456.499, F457.499, F458.499, F459.499, 
F460.499, F461.499, F463.499, F464.499, F466.499, 

F467.499, F468.499, F469.499, F470.499, F471.499, 

F475.499, F476.499, F477.499, F478.499, F479.499, 

F480.499, F481.499, F482.499, F483.499, F484.499, 
F485.499, F486.499, F488.499, F489.499, F490.499, 

F491.499, F492.499, F493.499, F494.499, F495.499, 

F496.499, F497.499, F498.499, F500.499, F501.499, 
F502.499, F503.499, F504.499, F505.499, F506.499, 

F507.499, F511.499, F512.499, F513.499, F514.499, 

F515.499, F516.499, F517.499, F518.499, F519.499, 

F520.499, F521.499, F522.499, F523.499, F524.499, 
F525.499, F526.499, F527.499, F528.499, F529.499, 

F530.499, F531.499, F532.499, F533.499, F534.499, 

F535.499, F536.499, F537.499, F539.499, F541.499, 
F542.499, F543.499, F545.499 

Settings 



Heat 

Transfer 

Adiabatic 

Boundary - impeller Default 

Type WALL 

Location F544.499 

Settings 

Heat 

Transfer 

Adiabatic 

  
 

4. Solution Report 
Table 5.  Boundary Flows for Copy of Fluid Flow CFX 

Location Type Mass Momentum 

X Y Z 

Default Fluid Solid 

Interface Side 1 ( 
Bulk-casing ) 

Boundary  8.2193e+05 -

1.1159e+05 

3.2650e+03 

Default Fluid Solid 

Interface Side 1 ( 
casing ) 

Boundary 0.0000e+00    

inlet ( Bulk-casing ) Boundary  6.1355e-02 1.6581e+06 -4.8153e-05 

inlet ( casing ) Boundary 8.4054e+03    

outlet ( Bulk-casing 

) 

Boundary  1.0165e+05 1.0941e+04 3.8683e+02 

outlet ( casing ) Boundary -

3.2584e+03 

   

wall ( Bulk-casing ) Boundary  -
9.8964e+05 

-
1.5692e+06 

-
3.5136e+04 

wall ( casing ) Boundary 0.0000e+00    
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